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Intro laser

‘Laser’ is originally an acronym for Light Amplification by Stimulated Emission 

of Radiation. The word has become so common that it is no longer seen as an 

abbreviation. Even in English, the word is therefore written without capital letters 

(just like radar).

A laser is an electromagnetic radiation source that emits light in an almost parallel 

beam. In order to cut with the laser beam, it must be focused into a circle of light 

with a diameter only a fraction of a millimeter. This makes the intensity of the jet so 

high that very narrow and precise slots can be made by melting and evaporating the 

material. The sharp laser beam can cut a large number of metals and non-metals such 

as plastics, glass, wood and textiles. Laser cutting of metal is possible from a power of 

100 watts. 12 watts is sufficient for cutting non-metals.

In addition to laser cutting, lasers are also used in an industrial setting for other 

purposes, such as engraving, welding parts and surface treatments such as hardening.

Laser light

A laser source provides a focused, energy-rich beam 
of light in one wavelength. The CO2 lasers used here 
are in the far infrared range.

By bundling the energy with a lens, it is possible to 
cut or engrave materials. Think of a magnifying glass 
and the sun ....

the energy is focused in such a way that when 
cutting acrylic (PlexiGlass), for example, the large 
amount of bundled energy ensures that the material 
does not melt, but changes directly from a solid to 
a gas! Hence the importance of the extraction and 
compressed air to directly discharge the released 
gases.

In many cheaper machines a glass 
laser tube is installed.

A metal laser tube, used in our 
machines.
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Intro laser

The cutting speed that can be achieved with laser cutting depends on a number of 

variables, such as the kind of material, the thickness of the material, the type of laser 

and the power.

For different applications, different wavelengths of the laser beam are used. A CO2 

laser, like the one we have at Mekano, has a wavelength of 10-6 µm(far infrared), a 

He-Ne laser has a wavelength of 6,328 µm.

Because a laser releases all its energy on a single wavelength, a laser beam is very 

powerful.

The cutting speed and cutting possibilities are very dependent on the quality and type 

of laser source, mirrors and lenses and varies roughly between 0.5 (for steel) and 12 

(for plastic) meters per minute. The laser machines at Mekano can only cut organic 

materials such as wood, cardboard, MDF and acrylic.

Daylight spectrum and the peak of a HeliumNeon laser at 632.8 nm
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Intro laser cutting

laser beam

lens

surface mirror

pressurised air

nozzle

focused laser beam

Laser cutting ensures a very fine cut and little material loss.

The heat-affected zone is therefore very small. With laser cutting, complex contours 

can be easily cut.

The laser beam can be transported over a distance due to its beam quality. The laser 

source and the workplace can therefore be set up far from each other. The “rough” 

laser beam is guided to the lens by means of mirrors. The beam is then focused at the 

workplace.

There is a connection for air supply on the laser head. This air blows exactly where the 

laser is cutting, removing the gases and material. Moreover, the overpressure in the 

nozzle ensures that no dirty deposits end up on the lens.

The lens and the 3 or 4 mirrors in the laser machine are high-quality optical parts, so 

you shouldn’t touch them.
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Laser cutters in the Mekano

The laser machines we have are relatively low-power machines, but offer more than 

enough power to process the materials that are available.

The larger laser cutter, the Epilog Legend XT, has 75 Watt laser power, the smaller 

Trotec Speedy has 30 Watt. Both machines can be used for cutting and engraving 

various materials.

Although this type of laser machine is equipped with many safety features, a laser 

machine must be used with common sense. Hence the obligation to follow this 

workshop and take a test, to demonstrate that you can work safely with the laser 

machines.

Because laser machines must comply with strict safety requirements by law, they are 

always safe with regard to the laser beam (class 1 or class 2). The danger in using the 

machine lies in the flammability of the material. During laser cutting, a lot of bundled 

energy is projected on a very small point which releases a lot of heat. If you direct a lot 

of heat into one place, the material can quickly ignite or smolder. Hence the rule that 

lines must be at least 2 mm apart.
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File preparation

At the Mekano we use Adobe Illustrator to create files for the laser cutter. You can of 

course draw in any other vectorial drawing program, but only from Illustrator you can 

send files to our laser. It is beyond the scope of this introduction to take a full course 

in Adobe Illustrator, but here are the instructions on how to properly prepare a file 

for the laser machines. Illustrator is also great for reviewing your file and making sure 

you get the desired result. Below we list the most important things you should pay 

attention to:

Start with a new file in Illustrator, 700 x 400 mm for the Trotec or 900 x 600 mm for 

the Epilog laser cutter - “landscape” format and not “portrait”. Also note that the color 

mode is in RGB and not CMYK.

All lines and areas must be in “outline” or “stroke” without “fill”.

Cutting lines:      RGB red   R: 255 - G: 0 - B: 0      line width 0.001 pt or mm. 

Engraving lines: RGB blue R: 0 -      G: 0 - B: 255 line width 0.001 pt or mm.

Attention:
In Illustrator, use a comma next to the N on the AZERTY keyboard, a period is ignored!
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Illustrator

You can engrave black text, logos, thicker lines and the like. Note, this takes a lot of 

time. First try a small part of your design to know the result and estimate how long it 

will take. 

Black text and ‘bold’ lines: RGB black R: 0 - G: 0 - B: 0 

Keep all lines and areas to be cut or to be engraved at least 5mm from the edge of 

the material to avoid cutting or engraving into the rulers of the machine. Remove all 

unnecessary items, including clipping masks and stray anchor points. Only what needs 

to be cut or engraved may remain. Once you press ctrl-y and ctrl-a, you see what 

the laser “sees”, so all vectors, even those that are otherwise invisible because they 

are, for example, white. Click ctrl-y again to return to the normal view. For complex 

designs, you may find it helpful to split the laser task across several layers in Illustrator. 

This allows you to split edits, or ensure that - if you have to stop prematurely - you 

already have some of your parts. You can then come back at a later time to cut the 

remaining layers. 

TIP: Always lay your material in the same way in the machine: top against the bar and 

then to the left in the corner. If your plate is not 100% perpendicular, it will still be 

good, and in any case always in the same position

Normal view

stray anchor points

Text and line in white now visible

after ctrl-y
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Illustrator

When creating your design, keep in mind that lines must be shared. Shapes or objects 

must have shared lines whenever possible. So you draw your design with this rule in 

mind. We give an example. Suppose you want to cut 6 squares. In example A we show 

you how NOT to do it. In example A no lines are shared. In example B lines are shared, 

this is the correct method. Cutting time is drastically reduced in example B. This is 

good for the laser cutters, good for the queues and good for your wallet. 

Nesting

If you want to cut some shapes, you want to arrange the shapes in a way that as little 

material as possible is used. With sustainability in mind, and avoiding unnecessary 

waste, it is mandatory to set up your design in such a way that there is minimal 

material loss. It is also the case that good nesting saves time. The laser cutter has to 

make fewer unnecessary movements. You can also check out software solutions that 

can apply optimal nesting to your design. On this website you can upload vector files 

in .svg format for nesting: https://svgnest.com/

Example A 
6 squares 30mm 
24x30mm=720mm

Example B 
6 squares 30mm 
17x30mm=510mm 
30% profit
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Common mistakes

Are you working in a version of Illustrator higher than CS6?
Always save your file as a CS5 file or lower, this can even be Illustrator 3.

Save as> Version:> Select Illustrator CS5.

 

Are you unable to set the colors of the lines correctly?
Make sure your file is formatted in RGB, and not in CYMK.

File> Document color mode> choose RGB. 

If your file was in CYMK, choose RGB and follow the steps below:

Select all (ctrl + a) > Edit > Edit Colors > Convert to RGB. Now you can put the lines 

in the correct color. Sometimes the color jumps to grayscale, you can adjust this in 

window> Color> RGB.

Lines are not visible on your screen when line width is at 0.001 mm (Illustrator CC) 

Edit> Preferences> GPU Performance> Uncheck GPU Performance

 

Connect multiple plates?
Because you have to stay 5mm from the edge, but still want to connect plates, it is 

best to draw a frame in cutting lines (red) at 5mm from the edge. Put your design 

within this frame.
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Common mistakes

If you experience clipping masks when converting your file to Illustrator, use the 

script that you can download here, place it in the following folder: 

C:\Program Files\Adobe\Adobe Illustrator 2021\Presets\en_US\Scripts. 

Restart Illustrator. 

Then in Illustrator you can select File> Scripts> RemoveClippingMasks.

 

You want to easily remove overlapping lines?

Select All (control + a) > Object > Live Paint > Make

Then Object > Live Paint > Expand

Optional: Object > Ungroup

The laser cutter stops immediately after pushing start. 

Possible causes: The line thickness is not correct. 

Opacity is not set to 100% > Select all lines and fill in 100% at “Opacity”. 

All blue lines (engraving) will be cut out anyway (Epilog). 

Due to a bug in the software, it is necessary to add a red line somewhere in your 

design. This red line can be very small.

Selecting

If you want to select all lines with the same color, 

thickness or opacity go to: Select> same> ....
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Usage of the laser machine

Make sure your Illustrator file meets all the conditions for laser cutting. You can 

refresh your memory in our general Laser Cutting Guide. Check in at our desk before 

entering the laser cutting room, where your name will be entered into the software 

to start the time you spend in the laser cutting room. The time starts when you start 

working in the laser cutting room. So make sure you prepare everything well so that 

you can start using the laser cutter as soon as possible. Bring the files you want to cut 

with you on a USB stick or external hard drive, even if you use a MacBook or similar. 

In the laser room there is (usually) no internet available for students, so no files via 

email, Facebook, WhatsApp or the like.

During laser cutting it is not allowed to leave the laser cutting room. Keep an eye on 

the laser, some materials can easily catch fire and render the laser machine unusable. 

Replacing a laser machine is a costly affair (€ 25,000) and can easily take several 

months, so that you, and especially your fellow students, cannot use the lasers! Do not 

bring friends to the laser cutting room, it is a work area, not a meeting area. Make sure 

you can operate the machine correctly before deciding to use it.

With the Trotec laser, laser cutting is done directly from the computer, with the Epilog 

laser the cutting file is moved to the machine and processed from the machine.
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New laser room

In our beautiful new sound-insulated laser room we have a completely new central air 

filter system. The large filter machine is set up outside the laser room to limit noise 

pollution as much as possible. This unit is switched on by the employee. For every laser 

machine there is a valve that you have to open when you start using the laser.

With the Epilog laser, you also have to turn on the compressor of the air assist.

Do not forget this!

You open the cover by raising the black switch on the box on the wall next to the laser 

machine. If no other student comes right after you, close it again when you’re done. 

This is also the only button you can touch outside the laser machine; so stay away from 

the main panel of the filter installation.

An air conditioner has been installed for the right temperature. This may / can only be 

operated by the employee. Above all, don’t touch it.

Due to noise nuisance and air conditioning, we keep the door of the laser room closed 

as much as possible.

In principle, there is only one person in the room per device (laser machine or 3D 

printer).

Make sure that the switch at the laser machine 
you use is up to open the valve

This is where you switch on the 
compressor for the Epilog’s air assist. 
If you forget this, there will be 
serious fire hazard !!!
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Using the Trotec

In the Illustrator ‘File’ menu, choose ‘Print’. 

In the ‘Print’ window check if you have selected the Trotec Engraver v11.0.0 and click 

‘Setup’.

In the next window click ‘Preferences’. 

Now you will enter the Trotec laser cutter software. Under the tab “Material settings” 

you will find a main list of all materials that you can use in the laser cutter. Make sure 

you choose the right material from this list, if you have any doubts ask our staff for 

help. 

After you have chosen the main category of materials, choose the preset 

specifications such as thickness or wood type in the menu below. If you have any 

doubts, ask our employees for help. Do not experiment with other materials and 

settings without having tested them in the presence of our employees. You can 

drop by at any time to make an appointment with our staff and test or experiment 

materials at no cost. 

If all settings are correct, click the blue “JC” (JobControl) button to return to 

the printer window.
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Using the Trotec

In this final print window you can see a preview of your file as it will be cut. If the 

print preview does not look correct, in some cases you still have to choose “Trotec 

700x400” or “User defined Paper” in the “Media Size” menu at the bottom. Click 

“Print” to send your file to the Trotec laser cutting software (JobControl). 

If you have done everything correctly, this software will open automatically. If the 

Trotec software window does not open you can click it in the Windows user bar at the 

bottom of the screen. 

If you have done everything correctly, your file will be in the list of files on the right 

side of the Trotec software window. When you click on your file you will see a small 

preview below the list of files. Your cutting and engraving lines should already be 

visible in there. If anything is not visible, the color or line settings in your Illustrator 

files are probably wrong. Double click your file in the list and it will jump to the 

‘cutting table’ in the top left corner. 

You can click the ‘WYSIWYG’ button (the eye) to see a preview of your file on the 

cutting table. If you are the first to use the Trotec laser cutter, or if the machine has 

been switched off before, you must connect to the machine by clicking the ‘connect’ 

button, this looks like a USB plug when the machine is not connected.
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Using the Trotec

If the machine was already on, you will see a blue “start” arrow. Be sure to put your 

material in the machine before continuing. If possible, place material that is not 

completely flat with the convex side up. 

 

If the lighting in the Trotec is not on, the machine is in stand-by mode. You can activate 

the machine with the black button (small indicator light is on) in the top center of the 

control panel

 

Carefully open the plastic lid of the Trotec Speedy 300 laser cutter and place your 

material in the top left corner on the honeycomb grid in the machine. Be careful not 

to damage the honeycomb grid or the lens part of the machine. Damaged or dirty 

parts cause inferior cutting work and can lead to failure. Ask our staff for help if you 

have any doubts about entering your material correctly. Never place more than one 

sheet of material in the machine and check that the honeycomb grid is clean and free 

from previous trimmings. Your material should lie flat on the honeycomb grid. 

After you have placed your material on the grid, you need to focus the laser beam to 

get a correct result. Make sure there is sufficient distance between the laser head and 

your material. First you move the lens part anywhere above your material. You do this 

with the four red buttons on the control panel to the right of the Trotec machine.
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Using the Trotec

Then you raise the table to focus the lens on your material. The red light beam is only 

used for focusing and is not dangerous. The laser beam used to cut is invisible! You 

can focus the lens by moving the table up and down with the two black buttons on the 

control panel to the right of the Trotec machine. For this you also need the focus tool.

We always place the focus tool on the narrow edge on the inside left of the machine. 

Always put it back there, if you lose the focus tool, the Trotec machine can no longer 

be used!

Take the focus tool by the red screw to place it in the lens holder. There is a small 

copper square on the inside that fits loosely in a slot on the lens holder. 

Carefully place the focusing tool in the lens holder and move the cutting table up 

with the two black buttons on the control panel on the righthand side of the Trotec 

machine. When the material is nearly touching the focus tool, use light taps on the 

button to raise the cutting table. The focus tool should just touch the material to be 

correctly set for perfect cutting and engraving. If the material is out of focus, you will 

get poor cutting results and burn marks on your materials.
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Using the Trotec

If you have several files to cut in the same material, you only need to focus once. If you 

want to cut files in different materials you have to focus for each material.

When your material is in focus, remove the focus tool and put it back on the narrow 

edge on the inside left of the Trotec machine. You don’t have to put the laser back 

in the starting position, that happens automatically once the machine starts cutting. 

Close the lid of the Trotec machine carefully and go back to the computer to start 

the cutting process. If you want to know how long it will take to cut your file, click the 

‘Update’ button under the ‘Estimate’ tab . The color bars tell you how long it will take 

to raster engrave (black), cut (red), and vector engrave (blue) your file. 

When everything looks right, click the blue arrow to initiate the cut.

Never open the hood of the machine while it is in operation, if you are not sure that 

everything is going normally, you can press the ‘pause’ button on the control panel 

of the Trotec machine and ask for help from our employees. If you press pause, the 

machine will usually not stop immediately, but will finish a line segment first. Only 

press the button once.
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Using the Trotec

When the cutting is done, wait 30 seconds before opening the lid to make sure all 

dust, smoke and gases have been removed. Remove all your cut pieces and leftovers 

from the machine, you can use the vacuum cleaner for this, but be careful not to 

damage the honeycomb grid. It is a good idea to bring paper tape to tape all the 

small pieces together when you take the material out of the machine. The Mekano 

has no tape available for students. Also know that small pieces will fall through the 

honeycomb grid and be lost forever. 

Once your file is cut, select it in the Trotec software and remove it. Take your waste 

to the correct waste containers and leave the laser cutting area tidy for the next user. 

Check out at our desk and pay. 

If you have reserved laser time, you have one hour in the laser cutting room. This is 

always a full hour. Make sure you are on time and especially that you leave the laser 

cutting room on time so that the next student can start on time.

Don’t start a new file if you only have a few minutes left; “just engraving” also takes 

a lot of time. If every student overstays for a few minutes, we get into huge trouble 

at the end of the day. This is certainly important in busy times, right before the juries. 

Respect the laser time of your fellow students.

Some concerns

If you want to use the laser machines in 
the Mekano, there are a few rules that you 
should take into account.

• files can be opened in Adobe Illustrator
• files on USB stick or external disk
• only use approved materials
• bring masking tape to keep small parts 

together
• if you make a lot of parts, bring an 

enveloppe, bag or box
• stick to the reserved time
• stay with the laser: fire hazard!
• no groups in the laser room
• clean up when you’re done
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Using the Epilog

The Epilog works slightly differently than the Trotec. 

In the Illustrator ‘File’ menu, choose ‘Print’. 

 

 

In the ‘Print’ window, choose ‘Print Preset’ for Epilog 900x600 and check if you have 

the Epilog Engraver WinX64 Selected under ‘Printer’ and click ‘Setup’. 
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Using the Epilog

Under the tab “Advanced” you can find presets for the most commonly used materials 

that we use in the laser cutter. Make sure you choose the right preset for your 

material, if you have any doubts ask our staff for help.  

 

 

After you have selected your material, click on “Load”. This is important! Do not click 

“OK” before you have selected and loaded the correct material settings. Wait a few 

seconds until the correct material is loaded and then click “OK”. 

In the next window click “Print”.
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Using the Epilog

In this final print window you can see a preview of your file as it will be cut. Make sure 

your file is in the top left corner of the preview. If you want to cut a smaller file, you 

can place it in the top left corner in the “Placement” setting. Click “Print” to send your 

file to the Epilog 36EXT Laser Cutter. If you have done everything correctly, you will 

see your file in the control panel on the Epilog 36EXT Laser Cutter. 

 

If you have done everything correctly, you will see your file in the control panel on 

the Epilog 36EXT Laser Cutter. If the green “Data” light is flashing, your file is not fully 

loaded.  

Open the cover of the laser cutter by the handle under the control panel and place 

your material in the top left corner on the honeycomb grid in the machine. Be careful 

not to damage the honeycomb grid or the lens part of the machine. Damaged or dirty 

parts cause inferior cutting work and can lead to failure. Ask our staff for help if you 

have any doubts about entering your material correctly. Never place more than one 

sheet of material in the machine and check that the honeycomb grid is clean and free 

of previous trimmings. Your material should lie flat on the honeycomb grid. 

 

 

After you have placed the material in the machine, close the hood of the machine 

carefully with the same handle. Make sure you have turned on the air assist and 

fume extraction. 
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Using the Epilog

You are now ready to press the magic “Start” button on the machine to cut your file.

 

The machine will first focus the lens on the correct thickness of your material and then 

start cutting. 

If you have also marked engraving lines, they will follow after everything has been cut. 

With the thin media settings in the Epilog software, you can engrave first and then cut 

(“cut_engrave” or “engrave_cut”). Make sure you always have a red line somewhere if 

you intend to engrave only. 

 

Once the cutting is done, wait 30 seconds before opening the hood to make sure all 

dust, smoke and gases have been removed. Remove all your cut pieces and scraps 

from the machine, you can use the vacuum cleaner for this, but be careful not to 

damage the honeycomb raster.

 

Take your waste to the correct waste containers and leave the laser cutting room tidy 

for the next user. Check out at our desk and pay.

Never open the hood of the machine while it is in operation, 

if you are not sure that everything is going normally you can 

press the “Stop” button on the control panel and ask our 

employees for help.

Here you turn on the 

compressor for the air assist.

If you forget this there will be 

serious fire risk !!!
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Fire Hazard

Fire hazard in the laser machine
If you laser cut certain materials, a small flame can form that follows the laser. 
This flame is burning gas that will auto-extinguish by and is not harmful, so no reason 
to panic.

Do immediately check if the compressed air (compressor) is on (Epilog) .

If the material itself burns when the laser cutting head has already moved on, you 
must intervene calmly:

• Press pause / stop. With the Epilog: emergency button on the front, turns off 
suction and air compressor.

• Start pumping pressure in the plant sprayer in front of the window. 
• Open the lid slightly.
• Spray with the plant sprayer on the burning / smoldering material.
• Warn the employee.

Observe the burning material. Usually the flame will extinguish itself when the laser 
stops adding energy.

If the burning is serious and you need to extinguish the fire in the machine, use the 
CO2 extinguisher. Position yourself so that you can exit the laser cutting room walking 
backwards. Hold the nozzle close to the hose, otherwise your hand may freeze. Place 
the CO2 extinguisher in front of the laser cutter, pull out the locking pin, and spray 
into the machine. The carbon dioxide snow will extinguish the flames.

The laser cutter lid when closed, is flame retardant, so leave it closed until you’ve 

come up with a plan.
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With some materials and in some situations you have to be very careful due to the risk 

of fire.

• Corrugated cardboard, especially the thicker version; there is a lot of air in this 

material and there are nice straight channels through which hot smoke and flames 

move easily. Corrugated cardboard can burn on the underside, without this being 

immediately noticeable. 

• Textile; some textile fibers are flammable.

• Paper and cardboard with cutting lines very close together: the heat build-up makes 

it very easy to catch fire. Keep at least a material thickness away. 

• One sheet of paper is no problem, but two sheets can have the same effect as with 

thick corrugated cardboard. So don’t do it! 

• If you color MDF or cardboard in advance with an aerosol, you have to let it cure 

very well, so that all volatile substances have evaporated. 

• Reflective material: the reflection is dangerous for your eyes, but can also send the 

laser beam back into the lens .... the machine is not happy with this.

Fire Hazard

1. top layer
2. corrugated layer
3. inter layer
4. corrugated layer
5. bottom layer
6. laser
7. heat

The thicker corrugated board is built of two layers.
In the lower layer heat can collect, this is a fire hazard.

1

2

3

6

4

7

6

5
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Laser cutting assignments

Create a simple document in Illustrator that includes all 3 main laser operations. It 

doesn’t matter which laser you choose.

So you have to raster engrave (black), vector engrave - also called kiss cut (blue) and of 

course cut (red). For example, make a key ring, with your name ...

Have your design approved by the employee and make it from a leftover piece of 

plywood, plexi or mdf. Show the result to the employee.

If you want to try something out, or just want to make something small, we always 

have a number of leftover pieces in the Mekano that you can use for free ... yes, for 

FREE.

If you want to laser your own material, you should always consult with the employee 

whether this material is suitable for the laser machine.

Cutting lines:     RGB red      R:255 - G:0 - B:0  

Engraving lines:  RGB blue R:0 - G:0 - B:255  

Black text:    RGB black R:0 - G:0 - B:0
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Introductie lasersnijden
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Laser cutting assignments

This assignment is mandatory for students that didn´t parcipate the former laser 

workshops. Have your design approved by the employee and make it from a piece of  

3 mm MDF, we have in stock for this assignment.

1  Open a new illustrator file, 600 x 310mm landscape, and choose for which laser 

cutter (Epilog or Trotec) you will create this file.

2  Draw 6 squares of 50 x 50 mm. These squares must be cut.

3 Put, in at least 3 squares, an engraved design

4  Draw 4 rings each with a width of 5mm and internal diameters of 80, 70, 60 and  

50 mm. 

5   Then draw an octagon to be engraved (raster) with a dimension of 40X40mm. 

6  Now draw a key chain with freely selectable shape and dimensions.  

Please note that cutting, vector engraving and raster engraving must be used.
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Laser cutting in a Corona era

Since the first corona measures were announced in March 2020, they have been 

adjusted many times.

We follow the prescribed guidelines within the buildings of the UA.

The current laser space is small; keeping your distance and ventilating is a problem.

We are currently working on a better space with adequate ventilation.

• You may only use the laser machines by appointment.

• It is very important to keep the prescribed distance to fellow students and 

employees.

• Make sure your laser file is completely in order. If in doubt, ask an employee to 

check this in advance, not in the laser room.

• Calculate how much material you will need and buy it in advance so that you don’t 

keep walking back and forth to the laser room. 

• Employees of the Mekano enter the laser room as little as possible when students 

are present. 

• Only one student per machine, at a time, is allowed in the laser room. 

• The handles, controls, keyboards and mice are cleaned several times a day.

• Disinfect your hands with hand gel when entering and leaving the laser room.

• Wear a mask, without a mask no access.
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